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1 -  How to see your class 
 

Select “Classes” tab from the menu on the left-hand side 

 

Select the class applicable from the drop-down list 

 

Select the Students tab on the right-hand side  

 

View the results displayed  
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2 -  How to start a test session 
Select the “Classes” tab from the menu on the left-hand side 

 

Select the Class applicable from the drop-down list 

  

Select the Start Test Session button on the right-hand side of the screen 

  

The following table will appear 

 

On the “Which test would you like to do? “ table click on the arrow to the right of the “Current 

Student Test” line to select the required test to be run. 

 

Once required test is selected “click on the Start Test Session button to run the session.  



5 

3 -  How to End the Test session 
 

Once the Students have finished the test session or if the Test session was incorrectly initiated and 
needs to be stopped, select the End Test Session button in the top right corner of the screen. 

 

 

Test Session will be stopped. 
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4 -  How to see test session results 
  

Select the “Classes” tab from the menu on the left-hand side 

 

Select the Class applicable from the drop-down list 

  

Select the Test session applicable to view results per class 

 

Select the student from the list for test results 
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Select the Analyze tab for details per student 

 

The detailed results will populate for all students that have partaken in this test 
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5 -  How to see students in your class 
 

Select the “Classes” tab from the menu on the left-hand side 

 

Select the class applicable from the drop-down list 

  

Select the Students tab on the right-hand side of the screen  
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6 -  How to see a student’s login details 
 

Select the “Classes” tab from the menu on the left-hand side 

 

Select the class applicable from the drop-down list 

  

Select the Students tab on the right-hand side of the screen to view students details 
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7 -  How to create a new class 
 

Select the “Classes” tab from the menu on the left-hand side 

 

 

Select the ‘+’ sign on the left of the screen 

  

 

Populate the fields with the new information and Save to create a new class 
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8 -  How to delete a Class 
Select the “Classes” tab from the menu on the left-hand side 

  

Select the class applicable from the drop-down list 

        

Select the Edit button on the right-hand side of the screen 

   

Select the Delete button on the Manage Class screen 
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9 -  How to Add a Student to a Class 
Select the Class the student needs to be added to 

 

Select the Students tab and then select the “+” sign to add a new student to the class selected 

 

 
Complete all the information required on the “Manage Student” screen and select Save to Add the 
student 
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10 - How to edit a student 
 

Select the “Classes” tab from the menu on the left-hand side 

 

Select the class applicable from the drop-down list 

 

  

Select the Students tab  

  

  

Select the Student required to edit 

  

 

Select the Edit button on the right-hand side of the screen 

 

  



15 

Edit fields required and Save to update Student details 
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11 - How to Delete a student 
Select the Classes tab on the main menu 

 

 

Select the class required 

Select the Students tab on the menu 

 

Select the Student to be deleted by ticking the box on the left of the line 

 

Select the bin icon from the menu 
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12 -  How to create a Group 

Groups facilitate selecting individual students from one or more classes to take part in a test 

session instead of running a test session for a whole class or even classes. 

Select the “Groups” tab from the menu on the left-hand side 

 

 

Available groups will populate, to create a new Group select the “+”sign above the word Group 

 

Populate the Management screen with the necessary information 

 

When information has been added Select Save to complete the addition of the Group.  



18 

13 - How to Add Students to a Group 
Students from different classes can be added to the same group, repeat below steps for each 

different class. 

Select the Classes tab from the menu on the left-hand side 

 

Select the Class required, and Select the Students tab 

 

 

Select the students to be added to a Group 
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Select the “clipboard” icon to add selected students to a Group 

 

 

Select the required Group from the drop-down list on the screen  

 

 
Select Assign to Add the students to the selected group. 

 

Once required students have been added a Test session can be started for the Group at your 
convenience. 

Test session options are available as normal; each student can do the test chosen by the Current Test 
allocated to that particular student or you can choose one particular test from the drop-down list for 
all the students in the group. 
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14 - How to Remove Students from a Group 
Select the “Groups” tab from the menu on the left-hand side 

 

 

Available groups will populate, Select the required Group 

 

Select the Students tab 
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Select the Students to be removed from this Group 

 

Select the “clipboard with Down arrow” icon to delete selected students 

 

Select “Yes” to remove student from the group.  
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15 - Where to find the student log in page and perform tests 
Select Student Test Page on the right-hand side of the screen 

 

The following screen will pop up 

  

For use on a different device scan the QR code with the required device. 

 

Select the Copy to clipboard button to copy the URL address 

 

 

To open the student test page Select the Open Test Page option 

 

Enter the username and password on the screen to access the Student Test Page 

 

Select Login to access the test. 
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Select the Start button to commence test 
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16 - How to do Practice tests   
Login to Student page (see 12) when logged in Select the Practice Zone button to do practice tests 

 

 

Select the required test from the drop-down list 

 

 

Practice test will begin. 
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17 - How to see a student’s test history 
 

Select the “Classes” tab from the menu on the left-hand side 

 

Select the class applicable from the drop-down list 

  

 

Select the Students tab on the right-hand side of the screen  

  

 

Select the Student applicable 

  

Select the Test History tab in the centre of the screen 
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18 - How to see a student’s test periods  
 

Select the “Classes” tab from the menu on the left-hand side 

 

Select the class applicable from the drop-down list 

  

 

Select the Students tab on the right-hand side of the screen  

 

 

Select the Student applicable 

  

 

Select the Test Periods tab in the centre of the screen 
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19 - How to move students between classes 
 

Select the “Classes” tab from the menu on the left-hand side 

 

 

Select the class applicable from the drop-down list 

  

 

Select the Students tab on the right-hand side of the screen  

  

 

Select the Student applicable 

  

 
Select Edit on the far right of the screen 
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20 - How to Import a list of students 
 

Select the “Classes” tab from the menu on the left-hand side 

 

Select the class applicable from the drop-down list 

(if new class first create a new class – ref to item 20) 

  

 

Select the Students tab on the right-hand side of the screen  

  

 

Select the Import button on the left-hand side of the screen 

Select the Student Import Template from the pop-up screen 

 

 

A new tab will open with the form to be completed,  
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Download the file by selecting the blue button on the right-hand side of the screen 

  

Open the downloaded file and populate the fields with the new students information  

 

Save the file and return to Edumania 

Select the upload button  

 

Select the Choose Import File button 

 

Select the saved Student Import Template file 

Students will be added to the class selected 
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21 - How to assign an attribute to a student 
 

Select the “Classes” tab from the menu on the left-hand side 

 

Select the class applicable from the drop-down list 

  

 

Select the Students tab on the right-hand side of the screen  

  

 

Select the Student applicable 

  

 

Select the Attributes tab on the right-hand side 

 
 

Click on the drop-down arrow sign next to the Add Attributes for list of Attributes 
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Select the Attribute applicable from the drop-down list 

  
 
Exit the Attributes options list (press Esc) and select the “+” to Add the Attribute to the Student 
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22 - How to edit an Attribute 
 

Select Attributes tab from the menu on the left-hand side 

  
 
Select the Attribute required and Edit all required fields on the “Manage Attributes” screen  

  
 
Save to update 
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23 - How to remove an attribute from a student 
 

Select the “Classes” tab from the menu on the left-hand side 

 

 

Select the class applicable from the drop-down list 

  

 

Select the Students tab on the right-hand side of the screen  

  

Select the Student applicable 

  

Select the Attributes tab on the right-hand side 

 
 
Select the bin icon next to the Attribute that needs to be removed 
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24 - How to add a test background colour per student 
Select the Classes tab on the main menu 

 

 

Select the class required 

Select the Students tab on the menu 

 

Select the Student required for the test colour by ticking the box on the left of the line 

 

Select the Edit tab from the menu on the top right hand side 
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Edit the colour required on the Student management screen 

 

Select the required colour from the pop up screen 

 

 

Save the changes by selecting the Save tab 
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When student accesses the test it will appear in the selected colour 
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25 - How to set what test a student is assigned to.  
 

Select the “Classes” tab from the menu on the left-hand side 

 

 

Select the class applicable from the drop-down list 

  

 

Select the Students tab on the right-hand side of the screen  

  

 

Select the Student applicable 

  

 
Select Edit on the far right of the screen 
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Edit the Test field by clicking on the drop-down arrow on the Manage Student screen 

 

 

Select the appropriate class from the drop-down list 

 

Save to update the new details 
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26 - How to edit what test a student is on. 
 

Select the “Classes” tab from the menu on the left-hand side 

 

Select the class applicable from the drop-down list 

  

 

Select the Students tab on the right-hand side of the screen  

  

Select the Student applicable 

 
 
Click on the Edit tab on the right-hand side of the screen 
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Select the Current Test option on the Edit screen for a drop-down list of test options 

 
Select option required 

 
Click on the Save option at the bottom of the Edit screen 
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27 - How to access the test page for a student 
 

Select the “Classes” tab from the menu on the left-hand side 

 

Select the class applicable from the drop-down list 

  

 

Select the Students tab on the right-hand side of the screen  

  

 

Select the Student applicable 

 
 
Select the Test History tab in the centre of the screen 
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Select the test required to view from the list displayed 

  
 
View test details 
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28 - How to see the contents of a test 
 

Select the Tests tab from the menu on the left-hand side 

 
 
Select the test required from the list displayed 

 
 

View table details 
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29 - How to edit your own password 
Select the Users tab from the menu on the left-hand side 

  
 

Select your user name from the drop-down list 

  
 

Select Change Password at the bottom of the Edit screen 
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Enter new Password and save to update the Password 
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30 - How to make an account 
 

Select the Users tab from the menu on the left-hand side 

    
 
Click on the “+”at the top of the screen 

 
 
Complete all the fields with the details for the new user 

  
 
Select Update to Add new user 
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Edit the Class field on the Manage Student screen 

 

 

Save to update the new details 
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31 - Reports 
Select the Reports tab from the menu 

 

 

Select the required fields from the drop down lists by Report type 

 

 

 

Select the required School/s 
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Select the required year/s 

 

 

Select the required test/s 

 

 

Select the Update tab on the far right of the screen to run the report 
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Report will populate and can be Viewed on the the screen or Printed, Saved, Shared, etc by right 
clicking on the screen and selecting the required option from the pop-up menu 

 

 

 

 

 


